LENESAS Quick Start Guide

RZ/V2N
Quick Start Guide for RZ/V Multi-OS Package

Introduction

This document outlines the procedure for integrating the RZ/V Multi-OS Package into RZ/V2N Al SDK. By
integrating the Multi-OS Package, users can efficiently establish a Multi-OS environment wherein Linux
operates on the Cortex®-A55 and FreeRTOS/BareMetal runs on the Cortex-M33 with support for Inter-
Processor Communication between these CPU cores.

This package requires the RZ/V Flexible Software Package (FSP) for an RTOS/BareMetal environment. The
figure below illustrates the software stack of the RZ/V Multi-OS Package with the RZ/V2N:

User Application RZ/V Multi-OS Package

Al Applications RZ/V Flexible Software Package

HAL Drivers

10Port GPFT POEG CMTW

UART SP1 FDM MHU
etc.

OpenAMP
FreeRTOS

RZ/V Linux

RZ/V Evaluation Board Kit

Here are brief descriptions of each component related to RZ/V Multi-OS Package:

e RZ/V FSP

This software package consists of production ready peripheral drivers, FreeRTOS and portable
middleware stacks and best in-case HAL drivers with low memory footprint.
e OpenAMP

The framework includes the software components required for Asymmetric Multiprocessing (AMP)
systems, such as Inter-Processor Communication.

Target Device
RZ/V2N
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1. Specifications
Table 1-1 lists the on-chip peripheral modules to be used in this package.

Table 1-1 Peripheral modules to be used in this package

Peripheral module Usage

Message Handling Unit (MHU) Configure Inter-Processor Interrupt.

Serial Communications Interface with FIFO (SCIFA) | Perform standard serial communications sending
and receiving console messages.

Interrupt controller (INTC) Handle the following types of interrupts as shown
below for example:

e Processors should receive interrupts during
buffered serial communications.

e MHU module fires Inter-Processor Interrupt.

General Purpose Input Output (GPIO) Configure 1/O lines used by serial communications.

General Timer (GTM) Configure the tick for FreeRTOS.

2. Verified Operation Conditions

Table 2-1 shows the verified operation conditions.

ltem Contents

Integrated Development Environment e? studio 2025-01

Toolchain GNU Arm Toolchain 13.3.Rell AArch32 bare-metal
target (arm-none-eabi)

Dependent Software o RZ/V Flexible Software Package (FSP) v3.1.0
o RZ/V2N Al Software Development Kit (SDK) v6.00

3. Sample Program Setup

3.1 Flexible Software Package Setup

Multi-OS Package expects RZ/V Flexible Software Package (FSP) to be installed in advance. For details on
the installation, please refer to Getting Started with RZ/V Flexible Software Package.

3.2 Integration of OpenAMP related stuff

This section describes how to integrate OpenAMP related stuff into RZ/V2N Al Software Development Kit
(hereinafter referred to as RZ/V2N Al SDK).

1. Carry out Step 1, Step 2 and 1-11 of Step 3 stated in How to build RZ/V2N Al SDK Source Code
showcased at Al Applications and Al SDK of RZ/V series.

2. Download Multi-OS Package (r01an7254ej0320-rzv-multi-os-pkg.zip) to a working directory and run the
commands stated below:

$ cd ${YOCTO_WORK}
$ unzip <Multi-0S Dir>/r01lan7254ej0320-rzv-multi-os-pkg.zip
$ tar zxvf r01an7254ej0320-rzv-multi-os-pkg/meta-rz-features_multi-os_v3.2.0.tar.gz

Here, <Multi-OS Dir> stands for the path to the directory where Multi-OS Package is placed.
3. Add the layer for Multi-OS Package.

$ cd build
$ bitbake-layers add-layer ../meta-rz-features/meta-rz-multi-os/meta-rzv2n
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(Optional for remoteproc support)

4. Uncomment the following lines stated in meta-rz-features/meta-rz-multi-os/meta-rzv2n/conf/layer.conf
for enabling remoteproc support:

#MACHINE_FEATURES:append = “ RZV2N_CM33_BOOT”
MACHINE_FEATURES:append = “ SRAM_REGION_ACCESS”
#MACHINE_FEATURES -append “ CM33_FIRMWARE_LOAD™
#MACHINE_FEATURES -append “ CA55_CPU_CLOCKUP”
MACHINE_FEATURES:append = " CM33_REMOTEPROC™

Be sure NOT to uncomment the above-mentioned 1st, 3rd and 4th line when remoteproc support is
enabled.

(Optional for CM33 invocation from u-boot)

5. Uncomment the following 2nd line stated in meta-rz-features/meta-rz-multi-os/meta-
rzv2n/conf/layer.conf. For details on CM33 invocation from u-boot, please see 4.3.2.

#MACHINE_FEATURES:append = “ RZV2N_CM33_BOOT”
MACHINE_FEATURES:append = “ SRAM_REGION_ACCESS”
#MACHINE_FEATURES -append “ CM33_FIRMWARE_LOAD™
#MACHINE_FEATURES -append “ CA55_CPU_CLOCKUP”
#MACHINE_FEATURES -append ' CM33_REMOTEPROC™

6. Carry out 11 of Step 3 of How to build RZ/V2N Al SDK Source Code for building Linux kernel related
stuff.

3.3 Note for Integration

The peripherals which are NOT enabled enter Module Standby Mode after Linux kernel is booted up. That
means the peripherals used on CM33 side might stop working at that time. To avoid such a situation, Multi-
OS Package incorporates the patch below:

o 0002-Set-OSTM-for-MCPU-and-RCPU.patch

This patch prevents GTM used in RPMsg demo program from entering Module Standby Mode. If you have
any other peripherals which you would like to stop entering Module Standby implicitly, please update the
patch as shown below:
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diff --git a/drivers/clk/renesas/r9a09g056-cpg.c b/drivers/clk/renesas/r9a09g056-cpg.-c

index c7a894c81cd9. .75000e8db473 100644

--- a/drivers/clk/renesas/r9a09g056-cpg.-c

+++ b/drivers/clk/renesas/r9a09g056-cpg.-c

@@ -266,14 +266,14 @@ static const struct rzv2h_mod_clk r9a09g056_mod_clks[] __initconst = {

DEF_MOD("'rcpu_cmtwl_clkm™, CLK_PLLCLN_DIV32, 4, 0, 2, 0),
DEF_MOD("'rcpu_cmtw2_clkm”, CLK_PLLCLN_DIV32, 4, 1, 2, 1),
DEF_MOD("'rcpu_cmtw3_clkm™, CLK_PLLCLN_DIV32, 4, 2, 2, 2),

- DEF_MOD('gtm_0_pclk", CLK_PLLCM33 DIV16, 4, 3, 2, 3),

- DEF_MOD('gtm_1_pclk", CLK_PLLCM33 DIV16, 4, 4, 2, 4),

+ DEF_MOD_CRITICAL("'gtm_0_pclk", CLK_PLLCM33 DIV16, 4, 3, 2, 3),

+ DEF_MOD_CRITICAL("gtm_1_pclk", CLK_PLLCM33 DIV16, 4, 4, 2, 4),
DEF_MOD("'gtm_2_pclk", CLK_PLLCLN_DIV16, 4, 5, 2, 5),
DEF_MOD("'gtm_3_pclk", CLK_PLLCLN_DIV16, 4, 6, 2, 6),

- DEF_MOD('gtm_4 pclk", CLK_PLLCLN_DIV16, 4, 7, 2, 7),

- DEF_MOD("'gtm_5_pclk", CLK_PLLCLN_DIV16, 4, 8, 2, 8),

- DEF_MOD('gtm_6_pclk", CLK_PLLCLN_DIV16, 4, 9, 2, 9),

- DEF_MOD('gtm_7_pclk", CLK_PLLCLN_DIV16, 4, 10, 2, 10),

+ DEF_MOD_CRITICAL("gtm_4 _pclk", CLK_PLLCLN_DIV16, 4, 7, 2, 7),

+ DEF_MOD_CRITICAL("'gtm_5_pclk", CLK_PLLCLN_DIV16, 4, 8, 2, 8),

+ DEF_MOD_CRITICAL("'gtm_6_pclk", CLK_PLLCLN_DIV16, 4, 9, 2, 9),

+ DEF_MOD_CRITICAL("gtm_7_pclk", CLK_PLLCLN_DIV16, 4, 10, 2, 10),

Re placing the DEF_MOD of the target clock with a DEF_MOD_CRITICAL patch prevents the Linux BSP
from changing the module to standby mode.

3.4 Deployment of RZ/V2N Al SDK

With respect to the deployment of Linux kernel, device tree and root filesystem for RZ/V2N, please refer to
https://renesas-rz.github.io/rzv_ai sdk/6.00/.

4. Sample Program Invocation on RZ/V2N

4.1 Hardware setup

Connect J-Link to RZ/V2N EVK. For details, please refer to Getting Started with RZ/V Flexible Software
Package.

4.2 CM33 Sample Program Setup
Here are the procedures for setting up the sample program running on CM33.

1. Extract r0lan7254ej0320-rzv-multi-os-pkg.zip on your development PC.

2. Extractrzv2n_cm33_rpmsg_linux-rtos_demo.zip included in r01lan7254ej0320-rzv-multi-os-pkg.zip.
3. Open e? studio 2025-01 and click File > Import.

4. Double-click General and select Existing Projects into Workspace as shown in Figure 4-1:
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B2

(T Cmiel

Figure 4-1. Import sample project (1)

5. Input the path to the directory where sample project you would like to import to Select root directory,
press Enter key and click Finish button.

3 -tk T

Figure 4-2. Import sample project (2)

(Optional)

6. By default, RPMsg channel 0 configured to be used on CM33. If you would like to change the channel,
you need to open the property of MainTask#0 on FSP Smart Configurator, specify the channel number
you would like to use for Thread Control and push Generate Project Content button. If Generate
Project Content pop-up is shown, click Proceed to reflect the changes to source code.
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Stacks Configuration

Threads 4| Mew Thread: s | Remove = MainTask#o Stacks. | Mew Gsch > L

o kel nhiac e fes P ke S emacd Ery ki the "Mew Stack” by button (sl or by pasting heee feam the cliplead

B Cenerste Project Content Py
Configuration rust be saved before genarating project content

’ Proceed with save and generatel

] Abways save and generate without asking

Sumrary | BSP Oee

1% protsems | B gon

MalnTask#0

Settings 7

Figure 4-3. RPMsg Channel Setting

7. Build the project from Choose Project > Build Project.
8. If building project is successfully completed, build artifacts as listed below should be generated in Debug
or Release directory of the project you imported in accordance with the active Build Configuration.
e rzv2n_cm33_rpmsg_linux-rtos_demo.elf
e rzv2n_cm33_rpmsg_linux-rtos_demao.bin

4.3 CM33 Sample Project Invocation for communicating with Linux

4.3.1 CM33 Sample Project Invocation using Segger J-Link
Carry out the procedure shown below for invoking CM33 sample project using J-Link:

1. Click Debug button as shown below:

Q 2025-01 - rzv2n_cm33_rpmsg_linux-rtos_demo/configuration.xml - &* studio

File Edit MNavigate Search Project RenesasViews Run Window Help
s-{@{sia-

Project Explorer X BES Y § ° B & rzv2n_cm33_rpmsg_linux-rtos_demo] FSP Configuration X

L A -

v =S rzv2n_cm33_rpmsg_linux-rtos_demo [Debug]

&P Binaries Stacks Configuration

Figure 4-4. Selection of Debug Configuration

2. If the following Select Configuration window is shown, choose rzv2n_cm33_rpmsg_linux-
rtos_demo_Debug_Flat or rzv2n_cm33_rpmsg_linux-rtos_demo_Release_Flat in accordance with the
build configuration you are using and click OK.
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@& Select Configuration O X

Select a configuration to launch:

[T rzv2n_cm33_rpmsg_linux-rtos_demo Debug_Flat|
[€7] rzv2n_cm33_rpmsg_linux-rtos_demo Release_Flat

|

Figure 4-5. Debug Perspective Launch (1)

If the following Confirm Perspective Switch window appears, press Switch to go ahead.

& Confirm Perspective Switch

This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective supports application debugging by providing views for
displaying the debug stack, variables and breakpoints.

Switch to this perspective?

[CJRemember my decision

Figure 4-6. Debug Perspective Launch (2)

3. When Debug Perspective is opened, Program Counter (PC) should be located at the top of
Entry_Function_S. Then, press the button shown in Figure 4.7.

B 2025-01 - rzv2n_cm33_rpmsg_linux-rtos_demo/rv/fsp/sre/ bsp/ cmsis/ Device/ RENESAS/Source/ cm/systems.c - ¢° studio
Fite Edt Source Refactor MNavigate Search Project RenesasViews Run Window Help

| -Q-ia[mlimsrze iR 6-Q-i%-tm-m]

Debug

BEx|d § =0 &
w & rov2n_cm33_rpmeg_linux-rtos_demo Debug_Flat [Renesss GDB Hardware Debuggir '
v i rov2n_cm33_rpmsg_linux-rtos_deme.elf [1] [cores: 0]
w @ Thread #1 1 (single core} [core: 0] {Suspended : Signal : SIGTRAP: Trace/breakp
= Entry_Function_S{) at systems.c:163 (xB002808.
s arm-nene-eabi-gdb (12.1)
s Renesas GDB server (Host)

L€] spstemse

= static void warm_reset_sub (void)

{

Set Secure vector address t

fu J d ., t sYsC *
R_BSP_SECURE_VECTOR_SET((uint32_t) &_ Secure_Vectors);

R_BSP_CM33_WARMRESET();
_asm volatile ("wfi™);
while (1)

{

H

¥

# * Entry function when debugging RAM load using a debugger{]
attribute_ ((naked)) void Entry Function_S (void)

/* Set the mpin steck pointer to BSP_PRV_SECURE_STACK_TOP */

s voletile ( Rsn men, %0"

¢ "r" (BSP_PRV_SECURE_STACK_TOP)
¥

Figure 4-7. How to start to debug Sample Project (1)
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4. PC should be stopped at the top of main function. Then, click the same button in the previous step to
continue.

Q +

® - % Rl | I [ i ¥~ Qu~i0y~ % 0 - e @ <&
Debug X - i+ § = A 9} [rzv2n_ecm33_rpmsg_linux-rios_demao] FSP Configuratior g systems L] main.c
~ e rzvan_cm33_rpmsg_linux-rtos_demo Debug_Flat [Renesas GDB Hardware Debuggir *(volatile uint32_t*) adr = data;

v 'T_—_ rzv2n_cm33_rpmsg_linux-rtos_demo.elf [1] [cores: 0] }
& i . . i -
¥ _?lhleadI 1 ”sm_gte core) [core: 0] (Suspended : Breakpoint) L 98 = static inline uint32_t _IOR32(uintptr_t adr)
= main() at main.c:104 Ox8004708 ag { e =
. arm-none-eabi-gdb (12.1) return *(volatile uint32_t*) adr;
. Renesas GDE server (Host) 181 }

= int main({void)

g_fsp_common_thread_count = @;
g_fsp_common_initialized = false;

Figure 4-8. How to start to debug Sample Project (2)

5. CM33 Sample Project starts to work and wait for the launch of CA55 RPMsg Sample Program.

4.3.2 CM33 Sample Program Invocation from u-boot
Here is the procedure for invoking CM33 Sample Program from u-boot:

1. Place rzv2n_cm33_rpmsg_linux-rtos_demo.bin together with Linux kernel and Device Tree Blob.

2. Insert SD card into SDO of RZ/V2N EVK.

3. Turn on RZ/V2N EVK. Then, you should see the following message on the console associated with CN12
of RZ/V2N EVK.

U-Boot 2021.10 (Nov 21 2023 - 11:34:15 +0000)
CPU: Renesas Electronics CPU rev 1.2

Model : Renesas EVK based on r9a09g056

DRAM: 7.9 GiB

MMC: mmc@15c00000: 0, mmc@15c10000: 1

Loading Environment from SPIFlash... SF: Detected mt25qu5l12a with page size
256 Bytes, erase size 64 KiB, total 64 MiB
OK

In: serial@11c01400

Out: serial@11c01400

Err: serial@11c01400

Net:

Error: ethernet@15c30000 address not set.

No ethernet found.

Hit any key to stop autoboot: O

=>

4. Hit any key within 3 sec. to stop autoboot.
5. Carry out the following setup on u-boot to kick CM33.

=> setenv cm33start “dcache off; mw.l 0x10420D2C 0x02000000; mw.l 0x1043080c
0x08003000; mw.l 0x10430810 0x18003000; mw.l 0x10420604 0x00040004; mw.1
0x10420C1C 0x00003100; mw.l 0x10420C0OC 0x00000001; mw.l 0x10420904 0x00380008;
mw. 1 0x10420904 0x00380038; extd4load mmc 0:2 0x08001e00 boot/
rzv2n_cm33_rpmsg_linux-rtos_demo.bin; mw.l 0x10420C0C 0x00000000; dcache on*
=> saveenv

=> run cm33start
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4.3.3 CM33 Sample Program Invocation with remoteproc
Here is the procedure for invoking CM33 Sample Program with remoteproc:

1. Booting up Linux by following RZ/V2N EVK Getting Started.
2. Invoke the command stated below to specify the sample program to be loaded:

root@rzv2n-evk:~# echo rzv2n_cm33_rpmsg_linux-rtos_demo.elf >
/sys/class/remoteproc/remoteprocO/firmware

3. Kick CM33 by invoking the command below:

root@rzv2n-evk:~# echo start > /sys/class/remoteproc/remoteproc0O/state

If CM33 Sample Program starts to work successfully, the following message should be shown on Linux
console:

root@rzv2n-evk:~# echo start > /sys/class/remoteproc/remoteproc0/state

[  20.859243] remoteproc remoteprocO: powering up cm33

[ 20.979447] remoteproc remoteprocO: Booting fw image rzv2n_cm33_rpmsg_linux-rtos_demo.elf, size
1681708

[ 20.988888] remoteproc remoteprocO: unsupported resource 4

[ 20.997938] rproc-virtio rproc-virtio.l.auto: assigned reserved memory node vdevObuffer@0x43200000
[ 21.007029] rproc-virtio rproc-virtio.l.auto: registered virtioO (type 7)

L 21.013825] remoteproc remoteprocO: remote processor cm33 is now up

4.4 CA55 Sample Program Invocation
This section describes how to invoke RPMsg sample program running on CA55 side.

1. Boot up Linux by executing the following command on u-boot for example:

=> run bootcmd

2. Login as root.

rzv2n-evk login: root

3. Invoke RPMsg sample program as shown below:

root@rzv2n-evk:~# rpmsg_sample_client

4. If the sample program started to work successfully, you can see the following message on Linux console:
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5. Type 1 if RPMsg channel 0 is used on CM33 RPMsg sample program under default setting. Otherwise,

metal: info:
Successfully
metal: info:
Successfully
Successfully
metal: info:
Successfully
Successfully
metal: info:
Successfully
Successfully
metal: info:
Successfully
Successfully
metal: info:
Successfully
Successfully
metal: info:
Successfully
Successfully

metal_uio_dev_open: No IRQ for device 10480000
probed IP1 device

metal_uio_dev_open: No IRQ for device 42f00000.

open uilo device: 42f00000.rsctbl.
added memory device 42f00000.rsctbl.

metal_uio_dev_open: No IRQ for device 43000000.

open uilo device: 43000000.vring-ctlO.
added memory device 43000000.vring-ctlO.

metal_uio_dev_open: No IRQ for device 43200000.

open uilo device: 43200000.vring-shmO.
added memory device 43200000.vring-shmO.

metal_uio_dev_open: No IRQ for device 43100000.

open uilo device: 43100000.vring-ctll.
added memory device 43100000.vring-ctll.

metal_uio_dev_open: No IRQ for device 43500000.

open uilo device: 43500000.vring-shml.
added memory device 43500000.vring-shml.

metal_uio_dev_open: No IRQ for device 42f01000.

open uilo device: 42f01000.mhu-shm.
added memory device 42f01000.mhu-shm.

Initialize remoteproc successfully.
Initialize remoteproc successfully.

*

rpmsg communication sample program *

. exit
lease input

VT ODONEPEF

. communicate with RZ/V2N CM33 chO
. communicate with RZ/V2N CM33 chl

type 2 for starting the communication.
6. By typing e, the sample program should be terminated with the message shown below:

please input
> e

[xxx]
[xxx]
[xxx]
[xxx]
[xxx]
[xxx]

42100000.
43000000.
43200000
43100000.
43500000.
42101000.

rsctbl closed
vring-ctlO closed
-vring-shmO closed
vring-ctll closed
vring-shml closed
bhu-shm closed

4.5 Overview of Sample Program’s behavior
This section describes the overview of sample program’s behavior.

1.

2.

When the CA55 sample program is successfully executed, the communication channel between CA55

and CM33 is established.

The CA55 sample program starts to send the message to CM33 with incrementing the message size from
the minimum value 17 to the maximum value 488. During the communication, the message as shown

below is displayed on your console:

[xxx] Sending payload number 148 of size 165

-mbox-uio.

rsctbl.

vring-ctlO.

vring-shmO.

vring-ctll.

vring-shml.

mhu-shm.
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3. When CM33 sample program receives the message sent from CA55, the echo reply is sent back to CA55
sample program.
4. When CAb5 receives the echo reply, the message below should be displayed on your console:

[xxx] received payload number 148 of size 165

5. After the 488-byte sized payload is sent from CA55 to CM33 and CM33 sends back the echo reply, the
message indicating the termination of the communication channel is sent from CA55 to CM33. Then, the
CAb55 sample program outputs the following log messages to your console:

[xxx]
[xxx] Test Results: Error count = 0
[xxx]
[xxx] Quitting application .. Echo test end
[xxx] Stopping application...

5. CA55 1.8GHz configuration support at CA55 cold boot mode

This chapter describes how to configure 1.8GHz as operational frequence of CA55 at CA55 cold boot.

5.1 Setup of CA55 related stuff
1. Uncomment the following lines in meta-rz-features/meta-rz-multi-os/meta-rzv2n/conf/layer.conf

#MACH INE_FEATURES :append
#MACHINE_FEATURES :append
MACHINE_FEATURES:append = “ CM33_FIRMWARE_LOAD”
MACHINE_FEATURES:append = “ CA55_CPU_CLOCKUP”
#MACHINE_FEATURES:append = ' CM33_REMOTEPROC"

“ RZV2N_CM33_BOOT”
“ SRAM_REGION_ACCESS”

Be sure NOT to uncomment the above-mentioned 1st and 5th line when CA55 1.8GHz support is
enabled.

2. Rebuild TrustedFirmware-A as shown below:

MACHINE=rzv2n-evk bitbake trusted-firmware-a -c cleansstate
MACHINE=rzv2n-evk bitbake firmware-pack -c cleansstate
MACHINE=rzv2n-evk bitbake core-image-weston

3. Deploy build artifacts to SD card by following Renesas RZ/V Al | The best solution for starting your Al
applications.

5.2 Setup of CM33 related stuff

1. Import or create RZ/V FSP project for CM33.

2. Open configurator.xml in the project and choose BSP tab.

3. Configure Clock up for CA55 properties as Enable. Also, enabled Launch CA55(core0) if you would like
to configure operational at CM33 cold boot mode.

4. Click Generate Project Content to reflect the changes to your project.
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B 2005-04 - cads_clockup_suppert/configurationarml - ¢ studia
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Project Explorar
w i ea5S_dodkup support

> wiF Inchudes.

Wy
5 @ v gon
i e
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fav.cly

2 seript
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» (7 Developes Assistance

Properties 3 Probiems Smart Browser
RZ/VZN Evaluation Kit
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part_number

Settings
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package_pins

v {2 Common
Secure stack size [bytes)
Main stack size [bytes)
Heap size (bytns)
BACU Vee (miV)
Parsmator checking
Assart Failuros

*[ea5_clockup_support] FSP Configurtion

Board Support Package Configuration

Device Selection

FSP wersion: (3,10 Saaed Detals

Board RENZN Evaluation it e - | (5
Device ROADSGOSENASGEG =
Core: Core 4CM33 0)

RYOS: Fronfiits

Samlnaﬂrxk‘ Pins | Interrupts: Evenit Links | Linker Sections  Stacks  Companents

Value

RIADSGOSENASGEG
a

1572864

LFBGA

840

01000
0x1000
CeA00G
3300
Disabled

=

Generate Project Cortent

[T Restore Defoults

Roturn FSP_ERR_ASSERTION

Errar Log Me Erver Log
PFS Protect Enabled
€ Runtime Initializatian Enablod
Earby BSP Initializatson Disabled

~ RZVIN
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~ RIVEN Family —==
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Figure 5-1. CM33 project setting for CA55 1.8GHz support (CA55 coldboot)

6. Build the project from Project > Build Project.
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€ 2025-04 - ca55_clockup_support/configurationxml - ¢ studio
File Edit Navigate Search Project Renesas Views Run Renesas Al Window Help

ﬁ}v«v- t}v%v

Project Explorer S B Y § 20 (ass dockup_support] FSP Configuration X == |
C
Viac:SS_ i Board Support Package Configuration o
> 45 Binaries Generate Project Content
> ) Includes ~
> B zv
s (B
J .,;a rv_gen Device Selecti
> & src
» & Debug FSP version: 3.1.0 Board Details
> & v dlg : -
) . Board: RZNZN Evaluation Kit vl
> &= scnipt
X| ca55_cdockup_support Debug_Flatlaunch Device: RIADIGOS6NABGBG =
\.‘3} configuration.xml Core: Core 4(CM33.0)
» (7) Developer Assistance
RTOS: No RTOS
v
< >

Summary BSP Clocks Pins Interrupts Event Links Linker Sections Stacks Components

Properties Problems Smart Browser  Console X b JRUIRTE - 4P x= 208 -=0
CDT Build Console [ca55_dockup_support]
BULLOING T1le: ../r2v/+sp/src/bsp/mcu/all/bsp_sorK. ¢ =

Building file: ../rzv/fsp/src/bsp/mcu/all/bsp_select_irq.c
Building file: ../rzv/fsp/src/bsp/cmsis/Device/RENESAS/Source/cm/dummy.c
Building file: ../rzv/fsp/src/bsp/cmsis/Device/RENESAS/Source/cm/startups.c
Building file: ../rzv/fsp/src/bsp/cmsis/Device/RENESAS/Source/cm/startup.c
Building file: ../rzv/fsp/src/bsp/cmsis/Device/RENESAS/Source/cm/system.c
Building file: ../rzv/board/rzv2n_evk/board_init.c
Building file: ../rzv/board/rzv2n_evk/board_leds.c
Building file: ../rzv/fsp/src/bsp/cmsis/Device/RENESAS/Source/cm/systems.c
Building target: ca55_clockup_support.elf
arm-none-eabi-objcopy -0 srec "caS5_clockup_support.elf” “caS5_clockup_support.srec”
arm-none-eabi-size --format=berkeley "ca55_clockup_support.elf"”

text data bss dec hex filename

16488 88 15759532 15776168 feb9sc cas5_clockup_support.elf

13:27:44 Build Finished. @ errors, © warnings. (took 4s5.497ms)

=**=* post-build Processing for project ca55_clockup_support ****
Post build script started

Post build script complete

Processing finished

Figure 5-2. Build CM33 project for CA55 1.8GHz support

5.3 Deployment of Build Artifacts to RZ/V2N EVK
This section describes the procedure to program the build artifacts to RZ/V2N EVK.

1. Connect CN12 of RZ/V2N EVK with Host PC and established serial port connection.

2. Configure DSW1-4 and DSW1-5 of RZ/V2N EVK as OFF and ON respectively to specify boot mode as
SCIF download mode.

3. Turn on RZ/V2N EVK. Then, the following message is shown on your terminal:
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VI COMO - Tera Term V1 o O b4

File Edit Setup Control Window Help
= SCI Downlood mode (Normal SCI boot)
—— Load Program to SRAM

~

Figure 5-3. SCIF Download mode

4. Send Flash_Writer_SCIF_RZV2N_DEV_LPDDR4X.mot to RZ/V2N EVK via terminal software. If it's
successfully transferred, the following message is shown on your terminal:

V' COM9 - Tera Term VT — O X

File Edit Setup Control Window Help

= SCI Download mode (Normal SCI boot)
-- Load Progrom to SRAM

—-- Start Boot Progrom on SRAM

Flash writer for R7/V?N Series V0.60 Jan. 26,2023
Product Code : RZ/VZN

Figure 5-4. Flash Writer invocation

5. Program bl2_bp_spi-rzv2n-evk.srec with Flash Writer as shown below:
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===== Qspi writing of RZ/G3S Board Command
Load Program to Spiflash
Writes to any of SPI address.
Micron : MT25QU512
Program Top Address & Qspi Save Address

===== Please Input Program Top Address ====

Please Input : H"8101EOQO0

===== Please Input Qspi Save Address ===
Please Input : H"00000

please send ! (*." & CR stop load)

Erase SPI Flash memory. ..

Erase Completed

Write to SPI Flash memory.

======= Qspi Save Information ===========

SpiFlashMemory Stat Address : H*00000000
SpiFlashMemory End Address : H"0001E95F

===== Qspi writing of RZ/G3S Board Command

Load Program to Spiflash
Writes to any of SPI address.
Micron : MT25QU512
Program Top Address & Qspi Save Address

===== Please Input Program Top Address ====

Please Input : H"00000

===== Please Input Qspi Save Address ===
Please Input : H"60000

please send ! (*." & CR stop load)

Erase SPI Flash memory. ..

Erase Completed

Write to SPI Flash memory.

======= Qspi Save Information ==========

SpiFlashMemory Stat Address : H*00060000
SpiFlashMemory End Address : H"0011ACFE

R01QS0078EJ0320 Rev.3.20
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7. Program CM33 FW (S-record formatted one) with Flash Writer as shown below:

===== Qspi writing of RZ/G3S Board Command =============
Load Program to Spiflash
Writes to any of SPl address.
Micron : MT25QU512
Program Top Address & Qspi Save Address
===== Please Input Program Top Address ============
Please Input : H"00000
===== Please Input Qspi Save Address ===
Please Input : H"202000
please send ! ("." & CR stop load)
Erase SP1 Flash memory. ..
Erase Completed
Write to SPI Flash memory.
—====== Qspi Save Information =================
SpiFlashMemory Stat Address : H"00202000
SpiFlashMemory End Address : H"00206A1A

6. CM33 cold boot support
This chapter describes how CA55 and CM33 related stuff should be built for CM33 cold boot.

6.1 Setup of CA55 related stuff

1. Uncomment the following lines in meta-rz-features/meta-rz-multi-os/meta-rzv2n/conf/layer.conf

MACHINE_FEATURES:append = * RZV2N_CM33_BOOT”
#MACHINE_FEATURES:append = “ SRAM_REGION_ACCESS”
#MACHINE_FEATURES:append = “ CM33_FIRMWARE_LOAD”
#MACHINE_FEATURES:append = “ CA55_CPU_CLOCKUP”
#MACHINE_FEATURES:append = " CM33_REMOTEPROC™

Be sure to uncomment the above-mentioned 3rd, 4th and 5th line when CM33 cold boot support is
enabled.

2. Rebuild TrustedFirmware-A as shown below:

MACHINE=rzv2n-evk bitbake trusted-firmware-a -c cleansstate
MACHINE=rzv2n-evk bitbake firmware-pack -c cleansstate
MACHINE=rzv2n-evk bitbake core-image-weston

3. Deploy build artifacts to SD card by following Renesas RZ/V Al | The best solution for starting your Al
applications

6.2 Deployment of CA55 Build Artifacts to RZ/V2N EVK

This section describes how to deploy CA55 Build Artifacts to RZ/V2N EVK. First, please carry out the same
procedure as 1 to 4 stated in 5.3 Deployment of Build Artifacts to RZ/V2N EVK. Then, follow the steps
stated below:

1. Program bl2_bp_spi-rzv2n-evk.srec with Flash Writer as shown below:
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6

1.
2.
3.

===== Qspi writing of RZ/G3S Board Command =============

Load Program to Spiflash

Writes to any of SPI address.

Micron : MT25QU512

Program Top Address & Qspi Save Address

===== Please Input Program Top Address ============

Please Input : H"8101EOQO0

===== Please Input Qspi Save Address ===
Please Input : H"100000

please send ! (*." & CR stop load)

Erase SPI Flash memory. ..

Erase Completed

Write to SPI Flash memory.

======= Qspi Save Information =================

SpiFlashMemory Stat Address : H*00100000
SpiFlashMemory End Address : H"0011E81F

===== Qspi writing of RZ/G3S Board Command =============

Load Program to Spiflash

Writes to any of SPl address.
Micron : MT25QU512

Program size & Qspi Save Address

===== Please Input Program Top Address ============

Please Input : H"00000

===== Please Input Qspi Save Address ===
Please Input : H"280000

please send ! ("." & CR stop load)

Erase SP1 Flash memory. ..

Erase Completed

Write to SPI Flash memory.

======= Qspi Save Information =================

SpiFlashMemory Stat Address : H"00280000
SpiFlashMemory End Address : H"0033ACFE

.3 Setup of CM33 related stuff

Import or create RZ/V FSP project for CM33.
Open configurator.xml in the project and choose BSP tab.

configure operational frequency of CA55 as 1.8GHz.

Click Generate Project Content to reflect the changes to your project.

Configure Launch CA55(core0) as Enabled. Also, enabled Clock up for CA55 if you would like to
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B 2025-01 - caS5_clockup_support/configurationxml - e studic
Fide Edit Mavigate Search Project Renesas Views Run Renesas Al

Window Help

FIORARECEE Bl T
Project Explorer < = W
v 5 a5 _dackup_support

» i Includes
> @ v
> 3 v gen
> B s -
Device Selection
* [ Debug
» v elg FSP vorsion: 310
» = saipt
b Board: RZ/VZN Evaluation Kit
| cab5_clockup_support Debug_Flatlaunch
Device:  ROADOGOSGNABGAG
» (@ Developer Assistance Core: Core 4{CM33.0)
RIOS: N RTOS

<

Surmmany Clocks: Pins: Interrupts

§ = 0O @ -ca55._dodkup support] FSP Configuration

Board Support Package Configuration

Board Details

Event Links Linker Sections  Stacks  Components

Properties Problems Smart Browser
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Settings Property Value
Early BSP Initializaticn Disabled
~ RIVZN
Launch Cf Enabled
Clock initialization Disabled
Clock up for CASS Disabled
~ RZVZN Family
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A ] »
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v
>
* Legend
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Figure 5-5. CM33 project setting for CM33 cold boot

5. Build the project from Project > Build Project.
6. Click Run > Debug Configurations... , expand Renesas GDB Hardware Debugging and choose
<project name> Debug_Flat.

E 2025-01- ca55_clockup_support/configuration.xml - ¢ studio
Eie Edit Navigate Search Project RenesasViews @ Window Help

DR B HEQ-
Project Explorer X
v 5 eaSS _clockusp wppert [Debug)
> &, Binaries
it Includes
s @ nv
& rzv_gen
B sre
& Debug
& rev_cfg
= scnpt
X ca55_clockup_support Debug_Flatlaunch

W oW v v

v

Renesas Debug Tools »
Q. Run Cul«F11
4% Debug F11 .
Run History »
© RunAs 5

Run Configurations...

Debug History »

17 DebugAs

|  Debug Cenfigurations...

Create, manage, and run configurations

T
| type filter text

[€] C/C++ Application

[€] C/C++ Remote Application

= EASE Script

[€] GDB Hardware Debugging

[£7 GDB Simulator Debugging (RH850)
@ Launch Group

{& configurationxml Q. Extemal Tools ¥ w [c] Renesas GDB Hardware Debugging
| rv_cfgxt | [e7 cas5_clockup_support Debug_Flat
> (@) Developer Assistance Core |c "] Renesas Simulator Debugging (RX, j]
Figure 5-6. Debug Configuration Launch
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7. Choose Debugger > Connection Settings and specify Yes to Reset after download.

Debug Configurations

]
Create, ge, and run config
I BeRX B Y- Mame: |c_355_clockup_s_uepart Debug_Flat
|r."F'_Ef'|te_" text @ M!inb- Startup | [T Common | k. Source
(&) C/C++ Application
[E] C/C++ Remiote Application Debug hardware: |J-Link ARM ~  Target Device: RIADIGOSTHI4GBG_
.| EASE Script
(] GDB Hardware Debugging GDB Sem'ngs Debug Tool Settings
[©7 GDB Simulator Debugging (RHE50) + J-Link o
3 Launch Group Type UsE v
w [t Renesas GDB Hardware Debugging J-Link Serial (Auto)
[c7] ca55_clackup_support Debug_Fiat Settings File ${workspace_loc:/${ProjName}l/${LaunchConfighame}jlink! ]
£ Renesas Simulator Debugging (RX, RL78) Seript File
Leg File ${workspace_loc:/${ProjName)}/iLinkLog.log
Low Power Handling Ne v
~ IP Connection
Connection Method P via LAN
Host Name/IP Address[:port number]
Identifier
Tunnel Server
Port Number
Password
w Interface
Type SWD v
Speed (kHz} 15000 v
~ JTAG Scan Chain
Multiple Devices Ne v
IRPre o
DRPre
~ Connection
Register initialization Neo v
Reset at the beginning of connection Yes v
Reset at the end of connection No v
SRIES, v
b
U de (Byles FEFEFERY
Hold reset during connect v
Set CPSR(3bit) after download No )
Prevent Releasing the Reset of the CM3 Core Yes v
Secure Vector Address &_ Secure_Vectors
Mon-secure Vector Address
Hot Plug No
Disconnection Mode Continue v v
Filter matched 5 of 11 items Revist Apply
::' Debug Close

Figure 5-7. Connection Settings

8. Choose Startup and change the Load type of Program Binary to Symbols only.

&80
Create, and run
BoEX BT~ || Mame: [ca55_dockup_support Debug_Flat
F T o e

[T] €/C+= Application
[T] C/C++ Remote Application
=7 EASE Script
[€] GDB Hardware Debugging
[E7] GOB Simulator Debugging (RHES0)
& Launch Group
~ [£7] Renesas GDB Hardware Debugging
7 ca35_clockup_support Debug_Flat
[E7] Renesas Simulator Debugging (RX, RLTE)

Initialization Commands
[l Reset and Delay (seconds): 3
[ Hatt

Load image and symbaols

Load type Offset (hex)  On connect

| Filename
| Program Binary [ca55_... Yes

Figure 5-8. Startup Settings (1)
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9. Click Add... > Workspace... , choose srec file and click OK.

8 Add download module a b4

Select a workspace resource

v (= Debug "
= v
Load image and symbols. » > rrv_gen
Filename Load type Offset (hex)  On connect y B stc
| =] Program Binary [ca35_.. Symbols anly Yes - bin
e i.!.'i eif
Specify download module name: eifin
- | e
5 s Edit ] rpd
Variables... Search Project... File System.., =) shd
Remode I—ﬁ—l
- — s R —11 5
5 Cancel it compile_commands.json
T Move dawn & makefile
makefile.init
|| memory_regions.ld
& objects,mk v
[1] Main | %% Debugger b Statup | [T] Common | & Source v
Initialization Commands
[JReset and Delay {seconds): 3 B Add download module X
CIHatt
. Specify download module name:
S{workspace_loc:\ca55_clockup_support\Debug\, . s
Load image and symbals Variables... Search Project... Workspace... File System...
Filename Load type Offset (hex)  On connect

Yes
T —— S

Figure 5-8. Startup Settings (2)

10.Click Debug to launch Debug Perspective. Note that DSW1-1, 4, 5 and 7 should be specified as OFF,
OFF, OFF, ON, respectively before the launch. Then, CM33 program starts, load CA55 build artifacts
from QSPI Flash ROM and kick CA55.

For details on CM33 program invocation with e2studio, please see Getting Started with RZ/V Flexible
Software Package.
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7. Remoteproc support

This chapter describes how to invoke the CM33 firmware with remoteproc on Linux.

7.1 Setup of CM33 related stuff

Here are the steps to develop your own project based on the projects that support remoteproc included in

this package.

1. Import the following projects as base projects.
— rzv2n_cm33_rpmsg_linux-rtos_demo

2. Change the project name (if you need).

In Project Explorer, right-click on the project name and select “Rename...”

8 Work - e studio
File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help
:_'é:. - 5& - (5] ﬁ - q -

Project Explorer = : ° =0

l }5 rzv2n_cm33_rpmsg_linux-rtos_demo f'

New
Go Into

Open in New Window

Renesas FSP

~ 1

Show In Alt+Shift+W >
& Copy Ctr+C
K Delete Delete
Source
I Rename... F2 I
i Import.. Rename ~r_nufcf
s Export...

ﬂ Rename Resource

New name: ‘ mvEn_cmBE_ﬁv_remoteprcd

Update references

Open preferences...

Preview >

OK

Cancel

Figure 7-1. Rename project
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3. Implement application code.
Replace the contents of main_task_entry function in src/main_task_entry.c with the following and
implement the application code.

/*

* Copyright (c) 2020 - 2024 Renesas Electronics Corporation and/or its affiliates
*

* SPDX-License-ldentifier: BSD-3-Clause

*/

#include "main_task.h"

/* Main Task entry function */

/* pvParameters contains TaskHandle_t */
#include "openamp/open_amp.h"
#include "platform_info.h"

#include "rsc_table.h"

extern int app (struct rpmsg_device * rdev, void * platform, unsigned long svcno);

void main_task_entry(void *pvParameters)

{
unsigned long proc_id = *((unsigned long*)pvParameters);
unsigned long rsc_id =*((unsigned long*)pvParameters);
struct rpmsg_device * rpdev;
void * platform;
int ret;

ret = init_system();

if (ret)

{
LPERROR("Failed to init remoteproc device.\n");
goto errl;

ret = platform_init(proc_id, rsc_id, &platform);

if (ret)

{
LPERROR("Failed to create remoteproc device.\n");
goto errl;

/I Add your code here

errl:
vTaskDelete(NULL);

Figure 7-2. Implement application code.
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4. Enable remoteproc.
Change the value of the ENABLE_REMOTEPROC macro in src/platform_info.h to 1.

. Waork - rzvZn_cm33_fw_remoteproc/src/platform_infoh - e studio

Ele Edit Source Refactor MNawvigate Search Project Renesas Views Run Window Help
R SR T R R

Project Explorer | 3Eys & ma k
rav2n_em33 fw_remeteproe [Debug A 82 * And edit config.h to s to 1
> & Binaries . -
* b Includes #define LPRINTF{format, ...) (printf_raw(format, ## _ VA_ARGS__))
» 0 #define LPERROR(format, ...) (LPRINTF("ERROR: " format, #% _ VA_ARGS_ )}
= Helse
y (0
A #define LPRINTF(format, ...) {}
v B s #define LPERROR(format, ...) {}

* |8 awo_to_allon_thread_entry.c o8 tgendif
x awo_to_allon_thread_entryh

gendif
blinky_thread _entry.c
blinky_throad_entry.h St T 4 £M33 F
: * If you to support remoteproc framework to loa 33 FW,
€255 start.c you need to set ENABLE_REMOTEPROC to 1.

a5 starth
of_load.c

o8 start.c

// Page s on L (Defau B)
» N crB starth #define PAGE_SIZE {exaleesy) {{ 4KB page size as the dafault value
| hal_entry.c
5 " Mailbox config
\OC i #define MBX_DEV_NAME "@x18450808. mbox-ui
2c_pmich #define MBX_NO (@xau) f* Maibox number (9, 1, this program uses */
> main_task_entry.c FrRT
s o MP_RPMg clg.h =struct ipi_info
g pd_all onc const char * name;
pd_axd_one const char * bus_name;
& h struct metal_device * dev;
» I pd_pd_onl struct metal_io_region * io;
* 48 platform_info.c uintptr_t irg_info;

int reglstered;
unsisned int mbx chnfCFG RPMSG SVCNOD1:

Figure 7-3. Enable remoteproc.

5. Build the project

B work - ravn_om33_tw_remoteproc/sic/plationm_infe i - ¥ studio = [} Es
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T ——— A R PLAIT L e s R e T 5 %
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et #define LPRINTF(format, ...)  {} £ MEX INT U
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s #define LPERROR(format, ...)  {} ¥
> By Bendif #  MBX_INT_NUM
» (# rzv_gon & MBX_INT_HUM
v fendiey # RSCMAX NUM
» 1€ awo_to_allon_thread_entry.c o &
» [ awo_to_allon_thresd_entry h . you want to support remoteproc framewerk to load ¥ PERRORS
s @ blinky_thread_entryc . you need to set ENABLE_REMOTEFROC to 1. H printt rawjconst char®, )
» (B blinky_thread entryh # )
v €] a5 starte # Lp
188 /f Page size on Linux (Default: 4K8)
S _start | : L " NTF
a5 pta iy 181 #define PAGE_SIZE (Bxe1e8al) /{ aKB page size as t N LPRINTHD
» 165 # LPERROR()
183 £/ Mailbox config # ENABLE REMOTEPROC
184 #define MBX_DEV_MAME "8x18488688 . mbox-uic” # PAGE SIZE
185 #define MBX_NO (Bxsl) f* Maibox numbar (8, 7
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» [€ 2¢ pmice 2 T 3 < i 5 >
> [B ize pmich
» [ sk et Bt Problens  Console Propertie PEE ) =0
» b CpenAMP_RPMsg_cigh b JEER T -
» B pdilane DT Bulld Consoie rzvEn_cm33.fw remoteproc]
S Building file: ../rzv/aws/FreeRTOS/FreeRT05/Source/tasks.c ~
» U pd_md onc Building target: rzv2n_cm33_fw_remoteproc.elf
» Lhl pd axl_onh arm-none-eabi-objcopy -0 srec "rzv2n_cm33_fw_remoteproc.elf” "rzvZn_cm33_fw_remoteproc.srec”
y 81 : arm-none-eabi-size --format=berkeley "rzv2n_cm33_fw_remoteproc.elf”
8 platfosm_info.c .
= : text data bss dec hex filename
> (W platiorm jnfo.h 35568 1364 15779864 15615996  F1553c riv2n_cm33_fu_remoteproc.elf
> Le] pll jinit.c
> [ pilinith 14:23:26 Build Finished. @ errors, 428 warnings. (took 13s5.229ms)
| pmig dermo.c *xss post-build Processing for project rzvan_cm33_fu_remoteproc ****
» & rsc_tablec Post build script started
n) rsc_tableh Post build script complete
4 Processing finished
» 45 rev_tproce - ~
< > < -3
5% rzv2n cm33 fw remoteproc B =

Figure 7-4. Build the project.
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6. Copy the image to rootfs.
Copy the elf file you created in the previous step to the /lib/firmware folder on the SD card that contains
the Linux rootfs you created in 3.4 Deployment of RZ/V2N Al SDK.

7.2 How to run CM33 firmware from remoteproc
Follow the steps in chapter 4.3.3 CM33 Sample Program Invocation with remoteproc.

However, change the echo argument in step 2 to match the file name of the file you copied in step 6 in the
previous chapter.

8. Reference Documents

e RO1AN6240 RZ/V2L, RZ/V2H, RZ/V2N Getting Started with Flexible Software Package
e R12UZ0157 RZ/V2N Evaluation Board Kit (Secure type) Hardware Manual
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and V4 (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.
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10.

11.

12.

13.
14.

(Notel)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
WWw.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
WWw.renesas.com/contact/.
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